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INTRODUCTION 

Excel 2007 is a very powerful and capable program; however, unless you understand the basics 
of using Excel, you won’t get much out of it.  

This guide introduces you to the basics of Excel so that you can begin to make use of this 
popular spreadsheet program.  The important elements of the Excel screen are shown to you so 
that you can get a quick idea of what’s going on.  Then it will show you how to create a simple 
spreadsheet, move around in Excel, edit your data, enhance the look of your spreadsheet, and 
use some of Excels great features.   

 The following pages present a brief introduction to selected features in Excel 2007. Those who 
use an Apple Macintosh computer for Excel can also utilize this documentation.  There is little 
difference between platforms once the application is open besides the new ribbon (toolbars) in 
2007. Just remember that this document is written for Excel 2007 and may contain updated 
features that may not exist in other versions.  Note that the document is not intended to cover all 
ways in which the basic features can be used or accessed.   

Have fun Excelling at work and remember that with practice, this program will become very 
simple to use. 

OVERVIEW 

When you start a new learning experience, the first task is to learn the language. You need to 
know what the basic elements are and where to find them. This document will help you learn the 
language of Microsoft Excel 2007 by understanding the basics of spreadsheet functions, 
capabilities, and the tools necessary.  

What is a Spreadsheet Program? 

A spreadsheet program uses worksheets and workbooks. A worksheet is like a traditional 
accounting ledger. It is divided into a grid of columns and rows. You can use an array of 
numbers and text on a worksheet. Spreadsheet programs have the ability to perform an 
assortment of functions. They are popular because they represent a better alternative to 
manually computing mathematical calculations and can be more accurate and time saving. In 
addition, with Excel numerical data in a spreadsheet can be converted easily into a chart for 
graphical presentation of the data. 
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Microsoft Excel 2007 

Microsoft Excel is a spreadsheet program that allows you to perform various calculations, 
estimations, and formulations with data. Excel 2007 is designed to work with texts and numbers 
by storing them in columns and rows.  It makes core spreadsheet functionality more accessible 
to all users. Formula creation, printing, and formatting allow easy access to the basic operations 
of the program.   

Excel 2007 permits: 

• A wide selection of fonts and options to be used in the creation of worksheets and allows 
you to create an impressive spreadsheet presentation.  

• Microsoft Excel includes a varied library of chart types that can be incorporated into 
spreadsheets to visually display data.  

• Has a basic database capability. Databases can be used in conjunction with 
spreadsheets. Simple databases can be constructed directly in the Excel program.  

The primary focus of this document is on Excel’s spreadsheet capabilities and functions and the 
basics about using Excel 2007. 

Excelling at Work with Excel 2007 

As a guide to Excel 2007 basics, this document presents an overview that will help a beginner 
build a simple worksheet and understand the basics of Excel 2007.  The Excel application has a 
complete and useful on-line help available through the Help menu as well.  

This document assumes: 

• You have a working knowledge of the Windows 95, 98, 2000, NT or XP environment 
including the use of a mouse.  

• For our Macintosh users, this document can be utilized for MS Excel 98 through 2004 for 
the basics of Excel. There is relatively little difference in the platforms and the versions 
at the basic level.   

Launching Your Excel Application 

1. Select the Start button  on the Taskbar at the bottom left corner of your screen. 
2. Point to All Programs. 
3. Select Microsoft Office 2007 from the submenu, and then select Microsoft Excel. 
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THE NEW LOOK IN OFFICE 2007 

The New Look and Feel in Office 2007 

The Office 2007 suite of software, which includes Excel, Word, Access and PowerPoint, now 
has a new look and feel to the layout of the menus and toolbars.   

• The traditional toolbars as we know them in previous versions have been reorganized 
into a Ribbon.   

• The tools that you are familiar with in previous versions are now displayed in tabs on the 
ribbon rather than in menus on the toolbar.   

• A Microsoft logo has been added to the upper left hand corner of each window.  This 
logo is an active File menu.  When the button is clicked, it will display a menu list to 
perform common functions like Open, Save, Print, Close.  

 This documentation will orient you to the new terminology used and where to locate necessary 
elements. 

Changes to Note 

Office 2007 uses a new format when saving documents.  This new format IS NOT Backwards 
compatible.  This means that if you share a document you have created in 2007 with someone 
who is using an earlier version of MS Office applications, they will not be able to open your 
document.   

What Are Your Options? 

a) Save to an earlier version of Word. Do a “Save As” and in the Save as type field, 
choose MS Office for 97-2003. 

o This will allow users with versions other than 2007, to open and work in your 
document.  

b) Users, who are working with an earlier version of MS Office, can download and 
install a compatibility pack. This will enable them to open a document saved in 
2007 format without you having to remember to save it as an earlier version. This 
link provides a bit more information: 

 http://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-3AE9-
4AEE-8F43-C6BB74CD1466&displaylang=en 
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TOOLS & FUNCTION 

Ribbons, Tabs and Toolbar 

Terms and Function 

Figure 1 – The New Look of the Toolbar 

1. Microsoft Office Button – Replaces the File menu. Commands found: 
o Open 
o Save 
o Print 

Note: It contains these common file and system commands and more (see Figure 2). 

Figure 2 – Microsoft Office Button Menu Options 
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2. Quick Access Toolbar – Contains shortcuts for the tools more commonly used. This can 
be customized to contain shortcuts that you use the most. By default, this toolbar will 
contain: 

o Undo 
o Redo 

3. Tab Bar – Replaces the menus traditionally used in prior versions. The Tab bar contains 
tabs. Each tab when selected displays groups of tools and commands in the ribbon 
associated with the tab (see Figure 3).For example, the Home tab contains the following 
commands: 

o Font Formatting 
o Alignment 
o Number Formatting 
o Styles 

Figure 3 – Tab Bar 

4. Ribbon – when a tab is selected, the ribbon displays a grouping of tools for that tab (see 
Figure 4). 

The Workbook Window 

The workbook window displays the Active Excel worksheet.  It is comprised of rows and 
columns. The columns are labeled with the letters of the alphabet, i.e. A, B, C, etc.  The rows 
are numbered down the left side. Rows and columns intersect to form cells.  Each cell can be 
referenced via its column name followed by its row number.  For example, the intersection of 
row 2 and column B is cell B2 (see Figure 4). 

Figure 4 – The Excel Workbook Window 
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1. Worksheet Area – Displays the current worksheet. 
2. Sheet Tabs – Displays tabs for the sheets in the current workbook. 
3. Status Bar – Contains worksheet information and shortcuts.  

Using the Ribbon 

The ribbon contains commands grouped by task. 

Figure 5 – The Ribbon 

• The Tab Bar – Contains tabs that display tools and commands in the ribbon. Each tab 
displays different functions.  

• The Command Button – is the short-cut icon on the ribbon, used to perform a specific 
function. 

• The Group – contains functions related to that specific grouping, 

• The Launcher – The launcher  opens a dialog box which contains more options for 
the selected group (see Figure 6). 

Figure 6 – Using the Launcher to open a group dialog box 

Customizing the Quick Access Toolbar 

The Quick Access Toolbar can be customized to meet your personal needs.  

1. Select the Customize Quick Access Toolbar icon (see Figure 7). 
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Figure 7 – The Quick Access Toolbar Icon 

2. A menu box opens (see Figure 8). 

Figure 8 – Quick Access Toolbar Menu 

3. Select More Commands from the resulting menu. 
 

4. The Quick Access Toolbar Excel Options Dialog box appears (see Figure 9). 
 

Figure 9 – Quick Access Toolbar (Excel Options Dialog Box) 
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5. Select the drop-down arrow on the Choose commands from field box and select a category from 
the resulting menu. 

6. Select the command you want to add from the left-hand side and then select the Add 
button. This adds the command to the right. The commands that appear on the right are the 
ones that will appear in the Quick Access Toolbar.  

7. To remove a command from the toolbar, go to the right, select the command that you want 
to remove, and then select the Remove button.  

8. Select the OK button when you are finished.  
 

Note: To quickly add a default command button to the Quick Access Toolbar, click the 
Customize Quick Access Toolbar button and select a command from the resulting menu 
(see Figure 8). 

GETTING STARTED 

Understanding the Excel Environment 

What is a Workbook? 

A workbook is a file that contains worksheets. It is the electronic equivalent of a three ring 
binder.  A single workbook can contain many, many worksheets.  It is the normal document or 
file type in Excel.   

 What is a Worksheet? 

Think of a worksheet as a page within a binder.  A worksheet is divided into a grid of columns 
and rows in which you input your data. 

 The Workbook Window 

An Excel workbook window is shown in Figure 1. 

 The Worksheet Window 

The worksheet window displays the Excel worksheet. It is comprised of rows and columns. The 
columns are labeled with the letters of the alphabet, i.e., A, B, C, etc. The rows are numbered 
down the left side. Rows and columns intersect to form cells. Each cell can be referenced via its 
column name followed by its row number. For example, the intersection of row 2 and column B 
is cell B2. 
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Figure 1 – The Excel Workbook Window 

1. Workbook File Title Bar – when the workbook is saved for the first time, the file name 
will appear in the title bar.  

2. Microsoft Office Button – contains common file system commands.  
3. Tab Bar – contains tabs that display tools and commands in the ribbon.  
4. Ribbon – contains groups of tools for use with Excel 2007. 
5. Worksheet Area – displays the current worksheet. 
6. Workbook Sheet Tabs – displays tabs for the sheets in the current workbook. 
7. Status Bar – contains worksheet information and short-cuts.  

Navigating in a Workbook 

• At the bottom of the workbook window (where the sheet tabs are located) are a 
number of controls you can use to move from worksheet to worksheet within a 
workbook.  

• Use the four tab scrolling arrow buttons in the lower, left corner only when you have 
more worksheets in a workbook than can be displayed at once.  

• The tab split box can be dragged to change the number of sheet tabs displayed. To 
reset the tab display, simply double-click the tab split box.  

• The scroll bars located to the right of the worksheet is another way to navigate in a 
worksheet.  

• The down arrows allow you to move forward and backward in your document.  
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Figure 2 – Workbook Navigation Options 

Selecting a Range (or Block of Cells) 

1. Select the first cell you want to include in the range. 
2. While holding the mouse button down, drag the mouse to include all cells you want to 

include in the range.  
3. Release the mouse button. The range is selected. 

ENTERING DATA INTO EXCEL 

Entering Data and Using Formulas 

There are three kinds of data you can enter into your Excel worksheet: 

1. Text (a label). 
2. A number (a value) 
3. A formula. 

Entering a Label (Text) or a Value (Number) 

1. Select the cell where you want to enter a label or a value (see Figure 1, below). 
2. Type a label (text) or a value (number). A label can include uppercase and lowercase 

letters, spaces, punctuation, and numbers. When typing values, do so without commas and 
dollar signs. You can format them later using the Format menu.  

3. Press the Enter key on your keyboard. 

Figure 1 – Worksheet Window 
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EDITING CELL CONTENTS 

There are several ways Excel allows you to edit cell content.  

1. In-Cell Editing 
2. Function Bar Editing 

In-Cell Editing 

In-Cell editing allows you to edit the information right in the cell itself. To do this: 

1. Select the cell you wish to edit by double-clicking on it. The insertion point appears 
within the cell.  

2. Make Corrections. You may use the mouse pointer or the arrows. Home and End keys 
to position the insertion point. You may also use the Backspace and Delete keys to 
erase unwanted characters.  

3. Type new characters if necessary.  
4. Press the Enter key on your keyboard to accept the edit, or press ESC to cancel it.  

Function Bar Editing 

Edits can also be performed right in the function bar. The function bar is located in the toolbar 
section. 

Figure 1 – Function Bar 

1. Select the cell you wish to edit.  
2. Single-click within the function bar. The insertion point appears within the bar.  
3. Make necessary corrections or additions. 
4. Press the Enter key on your keyboard to accept the edit. 
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COPYING AND PASTING CELL CONTENTS 

The Microsoft Office software allows for many ways to copy cell contents.   The command 
buttons on the Ribbon and using the right click of your mouse are just a few.  Which way you 
choose is your personal preference. 

Using the Ribbon Toolbar 

1. Select the cell or the range that contains the data you want to copy. 

2. Select the Copy con on the Ribbon toolbar (see Figure 1, below). An outline of the 
selected cells, called a marquee (looks like scrolling lines around the selected range of 
cells), shows the boundary of the selected cells. 

Figure 1 – Clipboard Group on Ribbon 

3. Select the first cell where you want to paste the data. 
4. Select the Paste button on the Ribbon toolbar.  

Using the Right-Click Button on Your Mouse 

1. Select the cell or the range that contains the data you want to copy.  
2. Right-click your mouse. A pop-up shortcut menu appears along with a formatting toolbar 

(see Figure 1). 

Figure 1 – Right-Click Shortcut Menu 
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3. Select Copy. 
4. Select the cell where you want to paste the data. 
5. Right-click again. 
6. Click Paste. 

MOVING CELL CONTENTS 

You can avoid retyping information by using the Move feature in Excel.  It is very simple to 
perform and can save you many keystrokes. 

Start by: 

1. Highlight the cell or the range that contains the data you want to move.  
2. Move your mouse cursor to one of the thick black outside lines surrounding your 

selection. Your cursor will change from a white plus sign to a black arrow.  
3. Press and hold your mouse button down and drag the selected range of data to where 

you want to relocate it. 
4. Release the mouse button.  

Note: Excel has moved the entire contents of the cell as well as any formatting that was applied 
to the cell or range of cells.  

DELETING CELL AND RANGE CONTENTS 

Excel allows you to delete the contents of a single cell or the contents of a range of cells at one 
time.  

Delete Unwanted Information from a Range of Cells 

1. Select the cell or range in which you wish to delete the information (see Figure 1, below). 

Figure 1 – Selecting a Range of Cells 
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2. Right-click the mouse button anywhere in the boundary of the highlighted range. 

3. Select Clear Contents in the pop-up shortcut menu that appears. 

The contents of the cell or cells selected are now cleared. 

USING AUTOFILL 

Copying a Formula to Other Cells Using AutoFill 

The AutoFill function will allow you to quickly and easily continue a formula down and across a 
range of cells relative in a worksheet. This function can save a lot of time where you would have 
to manually input the formula otherwise.  

1. Select the cell that contains the formula you want to copy or continue. 
2. Move the mouse pointer over the small black box, call the Fill Handle (see Figure 1, below), 

located in the lower, right corner of the active cell. The mouse pointer will turn into a black 
plus sign when you are properly over the handle.  

Figure 1 – AutoFill Handle 

3. Select and hold the mouse button down while dragging the Fill handle to highlight the range 
you want to copy the formula to. 

4. Release the mouse button. The formula is copied into the selected range of cells. 

INSERTING & DELETING ROWS AND COLUMNS 

Inserting a Blank Row or Column 

Sometimes when setting up a worksheet you realize that you do not have a row where you need 
it or you have a need for an additional column after you create your worksheet.  

To insert a blank row or column into your worksheet:  

1. Move the mouse pointer to the row or column heading where you want to insert the blank 
row or column. The row or column heading area is the gray area where the row numbers are 
to the left, or the column headings A, B, C are located at the top of the worksheet. The 
mouse pointer will turn to a black arrow pointing down the row or column (see Figure, 
below). 
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Figure 1 – Mouse Pointer Changes to an Arrow 

2. Select on the row or column heading. 
3. The row or column will highlight (see Figure 2 and 3). 

Note: Inserting a blank column uses the same steps as inserting a blank row with the exception 
of selecting the column where you want to insert and selecting Columns from the Insert menu. 

Figure 2 – Column Insert               Figure 3 – Row Insert 

4. Select Insert on the Menu bar, and then select Rows or Columns on the sub-menu. 
• For Rows – a blank row will be inserted about the selected row. 
• For Columns – a blank column will be inserted to the left of the column. 

Note: Multiple rows or columns can be inserted in the same steps when highlighting the range 
of rows or columns you want to insert. For example, if you highlight a range of 3 rows, then 
proceed with the Insert Rows command; Excel will insert 3 blank rows.  

 

Deleting a Row or Column 

Any row or column can be deleted from a worksheet. When a row or column is deleted, all the 
information that was contained in the row or column is also deleted. To delete rows or columns 
follow these steps: 

1. In the row or column headings, highlight the range of rows or columns to clear (see Figure 4, 
below). 
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Figure 4 – Selecting a Column 

2. Right-click within the highlighted range and select Delete from the submenu. The rows or 
columns that were selected will be deleted.  

Figure 5 – Right-Click Menu 
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CHANGING ROW HEIGHTS OR COLUMN WIDTHS 

Changing Row Heights of Column Widths 

Sometimes, you may need to manually adjust a column or row’s width or height in order to 
accommodate the information within the row or column.   

There are several ways to change the width of a column(s) or height of a row(s).  Select the 
range of rows or columns that you want to change. It could be one or ten or more rows/columns.  

Figure 1 – Selecting a Range of Columns 

Changing Column Width 

1. While holding the left mouse button down, drag the right-column border (the vertical line 
break between the columns) with the mouse until the column is the desired width.  

OR 

Double-click the right border of the column header to set the column width automatically to 
the widest entry in the column. 
 

Changing Row Height 

Excel adjusts row heights automatically to accommodate the tallest font in the row.  However, 
you can set the row height manually by using several techniques.  As with columns, you can 
select multiple rows. 

1. Drag the lower row border with the mouse until the row is the desired height. 

OR 

Double-click the bottom border of the row to set the row height automatically to the tallest    
entry in the row.  

To select multiple rows, either select and drag in the row header or press the Ctrl key while you 
individually6 select the rows.  
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FORMATTING WITH BORDERS 

Borders are lines that go from cell boundary to cell boundary as opposed to underlining which 
only underlines the content of the cell.  

Inserting Borders 

To insert a border line in a selected range of cells, rows or columns: 

Inserting Borders 

To insert a border line in a selected range of cells, rows or columns: 

1. Select or highlight the range of cells to apply the border. 
 

2. From the Home tab, select the drop-down arrow beside the Border Command button on 
the Ribbon (see Figure 1). 

Figure 1 – Border Command Button 

3. From the resulting menu, select More Borders. 

4. The Format Cells dialog box displays (see Figure 2). 
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Figure 2 – Format Cells Dialog Box 

5. The selected border style can be applied by selecting any of the three options under the 
Presets category or by selecting any of the Border options. 

6. Select the OK button.  

FONT AND FILL COLORING 

Color can be very effective. It can be used to emphasize a point, or it can also be used to help 
remind you of certain points in a worksheet.  With Excel, you can colorize the text, or the 
background color of a cell.   

Font Color 

It is very simple to colorize the text in your worksheet. Just follow these steps: 

1. Select the cell or range of cells. 
2. Select the Font Color command button on the Formatting toolbar (see Figure 1). 

Figure 1 – Font Color Command Button 



 
Excel 2007 – Basics         Page 20 of 32 

3. Select the small, black drop-down arrow, to the right of the icon.  
4. Excel displays a color palette (see Figure 2). Select the desired color.  

Figure 2 – Color Palette 

Fill Color 

Colorizing the background of a cell or range of cells can help make items stand out.  The steps 
are similar to those of font colorizing.  

1. Select the cell or range of cells. 
 

2. Select the Fill Color command button on the Ribbon (see Figure 3). 

Figure 3 – Fill Color Command Button 

3. Select the small, black drop-down arrow to the right of the icon.  

4. A color palette displays. Select the desired color.  

MAKING CHANGES TO THE SHEET TAB 

Changing the Name of the Worksheet 

Excel uses a default naming convention for its worksheets, such as Sheet1, Sheet2, and so on.  
This naming default is not very helpful or descriptive.  It makes more sense to name your sheet 
something that is applicable to its contents, especially when you have multiple sheets in a 
workbook.  Excel gives us the ability to rename worksheets.   

To change a sheet’s name: 

1. Double-click the sheet tab you want to change.  
 

2. The sheet tab is highlighted (see Figure 1, below). 
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Figure 1 – Workbook Sheet Tabs 

3. Type the new name.  

4. Select the Enter key.  

Colorizing the Worksheet Tab 

With Excel’s XP version and up, the colorizing sheet tab feature has been added. Colorizing can 
be very useful for organizational purposes. To colorize your worksheet tabs follow this simple 
step: 

1. Right-click on the sheet tab. 

2. Select Tab Color from the pop-up menu (see Figure 2). 

3. The color palette displays. Select a color. 
 

Figure 2 – Colorizing the Worksheet Tab 

 
Note: The active sheet tab is now underlined with the desired color. However, once the tab is 
inactive, the entire tab will be the desired color.  



 
Excel 2007 – Basics         Page 22 of 32 

Inserting Additional Worksheets  

Excel provides three (3) worksheets by default in a workbook.  Excel allows you to insert as 
many worksheets in the workbook, as the memory of your computer will allow.   

To insert a new worksheet, do one of the following: 

1. To quickly insert a new worksheet at the end of the existing worksheets, select the Insert 
Worksheet tab at the bottom of the screen (see Figure 3). 

Figure 3 – Insert Worksheet Tab 

2. To insert a new worksheet before an existing worksheet, select that worksheet, and then on 
the Home tab, in the Cells group, select Insert, and then select Insert Sheet.  

Figure 4 – Insert Worksheet Command 

 
Note: You can also right-click the tab of an existing worksheet, and then click Insert. From the 
Insert Dialog box on the General tab, click Worksheet, and then click OK. 

UNDERSTANDING FORMULA BASICS 

Formulas make spreadsheets useful.  Formulas are used to calculate results from the data 
stored in the worksheet.  When the data changes, formulas produce updated results without 
extra effort on your part.   

 To add a formula to a worksheet, enter it into a cell.  You can delete, move or copy formulas 
just like any other item of data.  Formulas use arithmetic operators to work with values, text, 
worksheet functions, and other formulas to calculate a value in the cell.   

Creating a Formula 

 A formula entered into a cell can consist of any of these elements: 

• Operators such as + for addition and * for multiplication.  
• Cell references, including named cells and ranges. 
• Values or text. 
• Worksheet functions such as SUM or AVERAGE. 
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Benefits of Using Formulas 

When using a formula in your spreadsheet, (a cell containing a formula that references other 
cells), the sum will automatically change as other cell values referenced in the formula change. 
This feature is very valuable when editing or adding information to your worksheet. You do not 
have to remember to update other cells that rely on that cell’s information.  

A formula always begins with an equal sign (=) followed by some combination of numbers, text, 
cell references, and operators. If a formula is entered incorrectly, an ERROR IN FORMULA 
message appears. 

Formula Operators 

An operator is a symbol that represents a mathematical or a logical operation. The most 
commonly used operators are addition, subtraction, multiplication or division.   However, 
there are many more operators that can be used.  Tables 1 and 2 (below) list the operators 
that can be used in Excel formulas and functions.  

Figure 1 – Operator Tables (Logical & Arithmetic) 
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Arithmetic Operators 

Arithmetic operators are used in conjunction with numbers to create mathematical formulas. 
An example of a simple mathematical formula in Excel would be =23+5. When this formula is 
entered into a cell in the worksheet, the contents of the cell will read 28, while the Formula Bar 
will show the formula as =23+5. If the operator is changed to read =23-5, the cell contents 
changes to 18. 

Cell references may also be used in formulas. For instance, assume you want the content of 
cell C5 to be the sum of values in cells A5 and B5. Instead of entering the values contained in 
cells A5 and B5 (and changing the formula each time those values change) you can enter the 
formula as =A5+B5. Excel will automatically take the values of A5 and B5 and enter them into 
the formula. The benefit of using cell references in your formula is that as the values change in 
the cells you reference in your formula, the value in C5 will automatically change to reflect the 
correct answer. 

How to Enter a Formula 

1. Select the cell you want to work with. 

2. Type the = (equal sign) to begin the formula.  

3. Type the first argument. An argument can be a number or a cell reference. You can type in 
the number, or if referencing a cell, you can single-click on the cell location, to have the cell 
reference automatically included in your formula. 

4. Next, type an arithmetic operator (see Figure 1, above). 

5. Enter the next argument.  

6. Steps 4 and 5 can be repeated as many times as needed. 

7. Press the Enter key. The result of the formula appears in the cell while the formula itself 
appears in the Formula Bar.  
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Figure 2 – Worksheet Window and Formula Bar 

Worksheet Functions 

Some formulas may be simplified by using worksheet functions. A worksheet function is a pre-
written formula, a keyword that tells Excel what to do. For example, instead of typing 
=A1+A2+A3+A4+A5, you may type =SUM(A1:A5). (The colon indicates the range from A1 to 
A5.) In this example, SUM is a function that Excel knows about. It is important to use the 
correct syntax and format of a function for correct results.  

To enter a function, do the following: 

1. Select the cell you want to work with.  

2. Type = (equal sign), then type the name of the function, followed by an open parenthesis. 

3. Select the cell you want to insert the function in.  

4. Press the Enter key on your keyboard. Excel automatically adds the closing parenthesis to 
complete the function and displays the results in the cell.  

Parentheses are used to separate different parts of a formula. For example, in the formula 
=SUM(A1:A5), the parentheses separate the worksheet function from the cell references that 
the function is referring to. This is particularly important in longer or more complicated functions, 
e.g., =((A2/4)+(A5-B3))*5. If a mistake is made and the parentheses in a formula do not match, 
an error message appears. 

The parts of a formula contained inside parenthesis are calculated first. Otherwise the order of 
operation is as shown in Table 3 (see Figure 3).   If there are operators of equal precedence, 
the order of operation is from left to right. 
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Figure 3 – Order of Operation 

Adding a Range Using the AutoSum Function 

The AutoSum function is a great tool to use when you want to quickly add contents of a range 
of cells.  It allows you to add cell content without having to manually input the formula or 
function. 

1. Select the cell where you want the total to appear (usually the last cell in the column or row 
of cells that you want to add. The cell must be blank). 

2. Select the AutoSum command button on the Home tab of the Ribbon. AutoSum 
inserts a formula that uses the SUM function. It displays a moving border that looks like 
scrolling lines around the selected range of cells. This is called a Marquee. Excel puts this 
around the range of cells it thinks you want to add, and inserts the range reference in the 
formula.  

3. If this is the correct range, press the Enter key on your keyboard. If not, type or highlight the 
correct range and press Enter.  
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PAGE SETUP 

The page setup is very important to the layout and printing of your worksheet. You may wish to 
perform the Page Setup function first, prior to inputting data on your worksheet. 

There are several ways to approach the page set-up functions.  The simplest is to: 

1. Select the Print Titles command button on the Page Layout tab of the Ribbon.  

2. The Page Setup dialog box appears (see Figure 1). 

3. Use the Page tab to adjust the page orientation, paper size and print scaling.  

4. Use the Margins tab to adjust the top, bottom, left and right margins as well as the 
header and footer margins.  

5. Use the Header/Footer tab to create a custom header or footer. 

6. Use the Sheet tab to print a selected area of the worksheet, repeat rows to print or 
print the gridlines.  

 

Figure 1 – Page Setup Dialog Box 
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7. Select the OK button when finished.  

Note: The Page Layout tab on the Ribbon contains many command buttons to define your 
page set-up as well.  

SAVING AND PRINTING 

Saving a Worksheet 

1. Select the Save icon on the Quick Access toolbar.  

Figure 1 – Quick Access Toolbar 

2. If you want to save the worksheet to a different folder (optional), select the Microsoft 
Office button and select Save As. 

3. The Save As dialog box appears.  

4. From the Save As dialog box, type the new workbook name in the File Name field.  

5. In the Save As type field, select the appropriate document type.  

6. Select the Save button. The new name displays in the Title bar. Remember, the Title bar is 
the bar at the very top of the application window.  

PRINTING THE ENTIRE WORKSHEET 

To print an entire spreadsheet quickly: 

1. Select the Microsoft Office button. 

2. Select Print from the menu (see Figure 1). 

3. From the Preview and print the document menu, select the appropriate option.  
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Figure 1 – Print Options 

PRINTING A SECTION OF A WORKSHEET 

1. Highlight the range you wish to print.  
2. Select File from the Menu bar and select Print to display the Print dialog box. 
3. Under the Print What section, in the lower, left of the dialog box, select Selection. Make 

sure the circle is filled in.  
4. Select the OK button.  
Figure 1 – Print Dialog Box 

 

Note: You may select other options in the Print window before you print your spreadsheet. For 
instance, you may print certain pages of your spreadsheet by filling the From: and To: boxes in 
the Print range area. You may also print several copies of your worksheet by selecting the 
Number of copies: option in the Print dialog box. 
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CLOSING AND EXITING EXCEL 

There are multiple ways to close a worksheet: 

1. Select the Microsoft Office button on the Menu bar. 
 

2. From the menu, select Close (see Figure, below). 

Figure 1 – Closing a Worksheet Using the MS Office Button 

 

Alternatively, you can click the Close button (X) located in the upper, right-hand corner of the 
worksheet window, this is the lower and smaller of the two buttons (see Figure 2). 

Figure 2 – The Close Button 

EXITING EXCEL 

To exit the program: 

1. Click the Close button (X), located in the upper, right-hand corner of the worksheet window, 
this is the lower and smaller of the two buttons. 

Note: If there are any open files that have not been saved since you last changed the 
worksheet, a dialog box will ask if you want to save the changes. Click Yes to save or No to 
ignore any changes you might have made. If no files are open or have been saved, Excel will 
close automatically. 
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LEARN MORE ABOUT EXCEL 

Microsoft on the Web 

Microsoft on the Web provides a wealth of on-line training.  You can further your Excel 
knowledge by visiting Mircosoft.com.  It is a great source for learning.  You need Internet 
connectivity and a Web browser in order to make use of this feature.   

For Beginning Excel  2007 Users 

On-line Training Tutorial for Excel 2007 Beginners 

http://office.microsoft.com/training/training.aspx?AssetID=RC100766511033 

 Quick Reference Card for Excel 2007 Beginners 
http://office.microsoft.com/training/Training.aspx?AssetID=RP100766581033&CTT=6&O
rigin=RC100766511033 

 Worksheet design strategy 

http://office.microsoft.com/en-us/excel/HA011082671033.aspx 

Get up to speed with Excel 2007 

http://office.microsoft.com/training/training.aspx?AssetID=RC100620751033 

Quick Reference Card for Get up to speed with Excel 2007 
http://office.microsoft.com/training/Training.aspx?AsetID=RP100766581033&CTT=6&Ori
gin=RC100766511033 

 TRAINING AND SUPPORT  

IT Training  

Contact Us:  
IT Training & Development  
Phone: (818) 677-1700 or x1700 (on campus)  
Email: 
 

training@csun.edu  

Troubleshooting and Support  
If you experience problems getting started with Office 2007 contact the Help Center at x1400 or 
helpcenter@csun.edu. 

 

http://office.microsoft.com/training/training.aspx?AssetID=RC100766511033�
http://office.microsoft.com/training/Training.aspx?AssetID=RP100766581033&CTT=6&Origin=RC100766511033�
http://office.microsoft.com/training/Training.aspx?AssetID=RP100766581033&CTT=6&Origin=RC100766511033�
http://office.microsoft.com/en-us/excel/HA011082671033.aspx�
http://office.microsoft.com/training/training.aspx?AssetID=RC100620751033�
http://office.microsoft.com/training/Training.aspx?AssetID=RP100766581033&CTT=6&Origin=RC100766511033�
http://office.microsoft.com/training/Training.aspx?AssetID=RP100766581033&CTT=6&Origin=RC100766511033�
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NOTES 
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